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Sanbolic® Melio™ Installation and User’s Guide 

Copyright and Disclaimer 

The information in this documentation was prepared by Sanbolic, Inc. with reasonable care and is believed to 

be accurate. However, Sanbolic, Inc. shall not assume responsibility for losses or damages resulting from any 

omissions, inaccuracies, or errors contained herein. Sanbolic, Inc. may make improvements or changes in this 

documentation or in the product and programs described in this documentation, at any time and without 

notice and as it sees fit. This publication describes the state of this product at the time of its publication, and 

may not reflect the product at all times in the future. 

No part of this documentation may be reproduced, stored in a retrieval system, or transmitted, in any form or 

by any means, electronic, mechanical, by photocopying, recording, or otherwise, without the prior written 

permission of Sanbolic, Inc. 

SANBOLIC, INC. MAKES NO WARRANTY EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY 

IMPLIED WARRANTIES OR MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, REGARDING THESE 

MATERIALS AND MAKES SUCH MATERIALS AVALIABLE SOLELY ON AN "AS-IS" BASIS. 

IN NO EVENT SHALL SANBOLIC, INC. BE LIABLE TO ANYONE FOR SPECIAL, COLLATERAL, INCIDENTAL, OR 

CONSEQUENTIAL DAMAGES IN CONNECTION WITH OR ARISING OUT OF PURCHASE OR USE OF THESE 

MATERIALS.  

The End-User Software License Agreement, which is included with the software program and this manual, 

specifies the permitted and prohibited uses of the software program.  

Please read the terms and conditions of the Agreement before commencing use of the software program. 

© Copyright Sanbolic, Inc., 2003. All rights reserved. 

Printed in the USA 

 

Trademarks 

Sanbolic and Sanbolic logo are registered trademarks of Sanbolic, Inc.  

Melio FS and the Melio FS logo are registered trademarks of Sanbolic, Inc.   

Third-Party Trademarks: 

Microsoft Windows 2003 and Windows 2008 are trademarks of Microsoft Corporation. All other brand names, 

product names or registered belong to their respective holders. 
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End-user License Agreement 

IMPORTANT NOTICE TO END-USER. PLEASE READ THE TERMS AND CONDITIONS OF THIS AGREEMENT 

CAREFULLY. 

THIS SOFTWARE LICENSE AGREEMENT („AGREEMENT”) IS A LEGAL AGREEMENT BETWEEN END-USER AND 

SANBOLIC, INC. („SANBOLIC”) FOR USE OF THIS SOFTWARE, INCLUDING THE ASSOCIATED PRINTED, ONLINE, OR 

ELECTRONIC DOCUMENTATION, CD-ROM MEDIA, COPY-PROTECTION HARDWARE, AND ANY AND ALL COPIES 

OF AND MAINTENANCE RELEASES TO THE SOFTWARE, AS WELL AS ANY THIRD-PARTY SOFTWARE EITHER 

EMBEDDED IN OR OTHERWISE INCLUDED AS PART OF THE SOFTWARE („SOFTWARE”). BY INSTALLING, 

COPYING, OR USING THIS SOFTWARE, END-USER IS DEEMED TO HAVE ACCEPTED AND AGREED TO THE 

FOLLOWING: 

1. GRANT OF LICENSE AND LIMITATIONS. In consideration for payment of the applicable license fees, 

SANBOLIC grants to END-USER and END-USER accept a personal and non-exclusive license to use the Software 

in object-code format, including the associated documentation, subject to the terms, conditions, and 

restrictions of this Agreement. END-USER may install a copy of the Software on a single computer owned, 

leased, or otherwise controlled by END-USER solely for its internal purposes. If END-USER wishes to make 

concurrent use of the Software on two or more computers, END-USER must acquire a license for each separate 

machine. END-USER agrees not to modify, adapt, translate, decompile, disassemble, or otherwise reverse 

engineer any portion of the Software, except and only to the extent expressly permitted by applicable law. 

END-USER may not sell, loan, lease, sublicense, or distribute the Software, or otherwise create derivative works 

based upon the software. Prior to disposing of any media containing the Software, END-USER agrees to erase 

or otherwise destroy any Software stored on such media. This license does not grant END-USER any right to any 

enhancements or new versions of the Software. Any such enhancements or new versions, if available, may be 

obtained by END-USER at SANBOLIC’s then current standard pricing, terms and conditions. 

2. OWNERSHIP OF SOFTWARE. All title, rights, and interests in and to the Software and underlying intellectual 

property rights in the Software are and shall at all times remain the valuable property of SANBOLIC or its 

suppliers. END-USER acknowledges that the Software contains valuable trade secrets or confidential and 

proprietary information of SANBOLIC, and that use of the Software does not transfer any title to or rights of 

ownership in the Software to END-USER. END-USER shall not remove or alter SANBOLIC’s or its supplier’s 

copyright, trademark, or other proprietary notices and legends included in the Software. END-USER agrees to 

take reasonable steps to prevent any unauthorized access, disclosure, distribution, possession, alteration, 

transfer, reproduction, or use of the Software. SANBOLIC and its suppliers reserve all rights not expressly 

granted to END-USER under this Agreement. THE SOFTWARE IS PROTECTED BY INTELLECTUAL PROPERTY LAWS 

AND INTERNATIONAL TREATIES. THE SOFTWARE IS LICENSED TO END-USER AND IS NOT SOLD. 

3. BACKUP COPIES. END-USER may make one (1) copy of the Software for security backup and archival 

purposes. END-USER shall place the same copyright and other proprietary notices and legends that appear on 

the validly licensed copy of the Software in any such backup copy. 

4. TRANSFERS. SANBOLIC shall have the right to assign its rights and obligations hereunder in whole or in part. 

END-USER may permanently transfer all of its rights and obligations under this Agreement to a third-party 

transferee provided that (i) END-USER transfers a validly executed assignment and assumption of its rights and 

obligations with respect to the Software; (ii) END-USER does not retain any copies of the Software or prior 

versions or upgrades, enhancements, or updates to the Software; (iii) END-USER provides SANBOLIC with 

notice in writing of the transfer and the name, address and contact person for the transferee; and (iv) the third-

party transferee accepts in writing the terms and conditions of this Agreement. Except as provided for above, 

END-USER may not transfer or assign this Agreement or any of its rights or obligations under this Agreement 

without the prior written consent of SANBOLIC, and any such unauthorized transfer shall be null and void. 
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5. LIMITATION OF WARRANTIES.  Sanbolic warrants that the storage media on which the Software is furnished 

will be free from physical defects in materials and workmanship under normal use for a period of thirty (30) 

days from the date of delivery to END-USER, and that such storage media shall contain a complete copy of the 

Software.  Any other software and any hardware furnished with or accompanying the Software is not 

warranted by Sanbolic.  As the sole remedy for any breach of the foregoing warranties in this paragraph, 

Sanbolic will replace any and all such defective media with media free from defects and containing a complete 

copy of the Software. 

EXCEPT AS STATED ABOVE IN THIS SECTION, THE SOFTWARE IS (AND ANY SERVICES OR SUPPLEMENTS NOW OR 

HEREAFTER PROVIDED WITH RESPECT TO THE SOFTWARE ARE) PROVIDED "AS IS" WITHOUT WARRANTY OF 

ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 

MERCHANTABILITY, NON-INFRINGEMENT AND FITNESS FOR A PARTICULAR PURPOSE.  SANBOLIC AND ITS 

SUPPLIERS SPECIFICALLY DO NOT WARRANT THAT THE FUNCTIONS OR FEATURES OF THE SOFTWARE WILL 

MEET ALL OF THE END-USER’S REQUIREMENTS; WILL OPERATE IN ALL THE PRODUCT COMBINATIONS WHICH 

MAY BE SELECTED FOR USE BY THE END-USER; THAT THE OPERATION OF THE SOFTWARE WILL BE ERROR-FREE 

OR UNINTERRUPTED; OR THAT ERRORS OR DEFECTS IN THE SOFTWARE WILL BE CORRECTED.  THE ENTIRE RISK 

AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE (OR ANY SERVICES OR SUPPLEMENTS NOW OR 

HEREAFTER PROVIDED WITH RESPECT TO THE SOFTWARE) IS WITH THE END-USER.  TO THE MAXIMUM EXTENT 

PERMITTED BY APPLICABLE LAW, END-USER EXPRESSLY WAIVES ALL WARRANTIES OR CONDITIONS NOT 

SPECIFICALLY SET FORTH HEREIN. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED 

WARRANTIES AND CERTAIN OF THE ABOVE EXCLUSIONS MAY NOT APPLY TO END-USER. NO AGENT, 

DISTRIBUTOR, OR RESELLER IS AUTHORIZED TO MAKE ANY ADDITIONAL WARRANTIES OR MODIFY THE 

FOREGOING LIMITED WARRANTY. 

6. LIMITATION OF LIABILITY. IN NO EVENT SHALL SANBOLIC OR ITS SUPPLIERS BE LIABLE FOR ANY SPECIAL, 

PUNITIVE, INDIRECT, CONSEQUENTAL, OR ANY OTHER DAMAGES, INCLUDING, BUT NOT LIMITED TO, LOSS OF 

PROFITS, LOSS OF REVENUE, LOSS OF USE, LOSS OF DATA, PROPERTY DAMAGE, OR ANY OTHER COMMERCIAL 

OR ECONOMIC LOSS OF ANY KIND ARISING OUT OF THIS AGREEMENT, OR THE USE OR PERFORMANCE OF THE 

SOFTWARE, OR THE RESULTS OBTAINED THROUGH USE OF THE SOFTWARE, EVEN IF ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGE, OR FOR ANY CLAIM BROUGHT AGAINST END-USER BY ANY OTHER PARTY, NOR 

SHALL SANBOLIC OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES WHATSOEVER RESULTING FROM ANY ACT 

BEYOND ITS REASONABLE CONTROL. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW. ANY 

LIABILITY OF SANBOLIC OR ITS SUPPLIERS FOR DAMAGES ARISING FROM EITHER THIS AGREEMENT, OR THE 

END-USER’S USE OR PERFORMANCE OF THE SOFTWARE, UNDER ANY LEGAL THEORY, WHETHER IN CONTRACT, 

TORT, NEGLIGENCE, STRICT LIABILITY OR OTHERWISE SHALL BE LIMITED EXCLUSIVELY TO REPLACEMENTOF THE 

SOFTWARE OR REIMBURSEMENT OF THE AMOUNT OF THE LICENSE FEES PAID BY END-USER FOR THE 

SOFTWARE, AT SANBOLIC’S SOLE OPTION. END-USER AGREES THAT THIS LIMITATION OF LIABILITY SHALL ALSO 

APPLY TO AND BENEFIT SANBOLIC’S SUPPLIERS, DISTRIBUTORS, OR RESELLERS. SOME JURISDICTIONS DO NOT 

ALLOW THE EXCLUSION OR LIMITATION OF SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, 

AND THE ABOVE LIMITATION AND EXCLUSION OF LIABILITY MAY NOT APPLY TO END-USER. 

7. TERMINATION. Without prejudice to any of its legal rights and remedies, SANBOLIC may terminate this 

Agreement if END-USER fails to comply with the terms and conditions of this Agreement. In the event of any 

such termination, END-USER shall discontinue all use of the Software, and return to SANBOLIC all copies of the 

Software in its possession. 

8. NOTICE TO U.S. GOVERNMENT USERS. If END-USER is a unit of the United States Government, the Software 

and associated documentation are provided with restricted rights. Use, duplication, or disclosure by the United 

States Government is subject to the restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical 

Data and Computer Software clause at DFARS 252.227-7013 or the restrictions set forth in (c)(1) and (2) of the 
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Commercial Computer Software Restricted Rights at 48 CFR 52.227-19, as applicable, or in successor provisions, 

including the limitations set forth herein. Manufacturer is Sanbolic, Inc., 304 Pleasant Street, Watertown, 

Massachusetts, U.S.A. 

9. MISCELLANEOUS. SANBOLIC and END-USER further agree that (i) this Agreement shall be constructed in 

accordance with and governed by the laws of a Delaware Corporation applicable hereto, without regard to its 

conflict of law rules; (ii) the parties expressly exclude the application of the United Nations Convention on 

Contracts for the International Sale of Goods, and any local or international law, convention, or regulation 

which may provide an alternative law or construction, to the extent such waiver shall be permitted by 

applicable law; (iii) if any term of this Agreement is deemed void and unenforceable, the remainder of this 

Agreement shall remain valid and enforceable; (iv) in the event of conflict between the terms and conditions of 

this Agreement and END-USER’ s purchase order, quotation, or other equivalent, the terms of this Agreement 

shall be controlling. No conflicting term or condition contained in any purchase order, quotation or other 

equivalent, shall be binding upon SANBOLIC in any fashion without SANBOLIC’s written consent; (v) the parties 

consent to this Agreement being drawn up in the English language; and (vi) this Agreement may not be 

amended except in a writing executed by both parties. 

10. ENFORCEABILITY. END-USER acknowledges that this Agreement is binding and shall entitle SANBOLIC to 

enforce the above terms. END-USER further agrees that SANBOLIC suppliers referenced in the Software are 

intended beneficiaries to this Agreement, and, to the maximum extent permitted by applicable law, may 

enforce this Agreement as it relates to their intellectual property rights. 

11. EXPORT RESTRICTIONS. END-USER may not export or re-export the Software except in full compliance with 

applicable export controls laws and regulations, and unless a validated export license is obtained from the 

applicable regulatory agencies, as required. 

12. ACKNOWLEDGEMENT. END-USER has read, understands, and agrees to be bound by the terms and 

conditions of this Agreement. IF END-USER IS NOT WILLING TO BE BOUND BY THE ABOVE TERMS, THE UNUSED 

SOFTWARE MAY BE RETURNED FOR REFUND OF THE LICENSE FEES PAID TO SANBOLIC OR THE DISTRIBUTOR OR 

RESELLER FROM WHICH END-USER ACQUIRED IT, PROVIDED THAT THE SOFTWARE IS RETURNED FOR REFUND 

WITHIN THIRTY (30) DAYS AFTER DELIVERY. PLEASE CONTACT THE VENDOR FROM WHICH YOU OBTAINED THE 

SOFTWARE FOR REFUND AND REFUND INSTRUCTIONS. 

 

 

Sanbolic, Inc., 2000. All Rights Reserved. 
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About Sanbolic® Melio™ 
 
Sanbolic Melio is a software-based product suite that augments existing application, server and 
storage infrastructures to alleviate the unintended consequences of virtualization. Comprised of 
advanced software components that work together to share storage and simplify data and storage 
management, Melio enhances the performance, scalability and availability of enterprise workloads in 
virtual datacenters and private cloud deployments. 
 
At the core of Melio is an all-purpose, 64-bit, symmetrical cluster file system called Melio FS™ that 
allows multiple Windows® servers to share simultaneous read/write access to data stored on the 
same partition or Logical Unit Number (LUN) on SAN (block-based) storage. 
 
A cluster volume manager called Melio Volume Manager is also included in Melio. Melio Volume 
Manager greatly simplifies management of Melio shared volumes while enabling advanced storage 
management functionality designed for enterprise and private cloud environments. 
 

Installation and Setup of Melio 

 
The following sections provide instructions for installing and using the Melio software to create shared 
storage for Windows® platforms. 
 

Minimal System Requirements: 
 

� Pentium IV class processor or equivalent 
� 512 MB RAM 
� 24 MB free disk space 
� LAN (TCP/IP) connection 
� SVGA - min 800x600, 256 colors 
� Block-based storage (i.e., iSCSI, Fibre Channel, Infiniband, etc.) 

 

Supported Operating Systems: 
 

• Windows Server 2003 x64 

• Windows Server 2003 R2 x64 

• Windows Server 2008 x86, x64 

• Windows Server 2008 R2 
 

Note: Windows Server 2003 x86 and Windows Server 2003 R2 x86 are not supported. 
 
Note: Melio 3.5 requires .NET Framework 3.5 SP1. Please ensure that .NET Framework 3.5 SP1 is 
installed on your computer prior to installing Melio 3.5. 
 

Recommendations: 
 

 Melio uses a proprietary communications protocol (based on TCP and UDP) for file system 
and volume management. To mitigate or remove the potential for heavy network traffic to 
adversely affect Melio communications, Sanbolic strongly recommends the use of a private or 
stand-alone network for Melio. This dedicated network can be created using a crossover cable 
for a two-server cluster or an Ethernet switch for clusters comprised of three or more servers. 
 

 To achieve even greater levels of performance, scalability and availability, while simplifying 
the management of Melio shared storage, Sanbolic strongly recommends using Melio Volume 
Manager to create and manage Melio shared volumes. Designed for shared storage, Melio 
Volume Manager allows administrators to create basic partitions, volume sets, stripe sets and 
mirror sets and take advantage of advanced storage features such as RAID1, RAID10, live 
storage migration and dynamic volume expansion. 
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Installation Checklist: 
 

• Using an account with local administrator privileges, log on to the system in which Melio is 
going to be installed. 

• Verify that the Windows Management Instrumentation (WMI) service is running. 

• Verify that the system has IP connectivity to the network that will be used for Melio 
communications. 

• Using the instructions provided by the manufacturer of your storage hardware, install and 
connect your storage hardware to the servers that will be running Melio. Once you’ve 
confirmed the storage hardware is operating correctly, create one or more LUNs and map 
them to the servers. Check the event logs on the servers for any storage connection-related 
error messages and resolve all reported errors prior to installing Melio. 

• Verify that the LUN(s) to be formatted with Melio FS is seen by Windows. To accomplish this, 
open a DOS prompt and enter the following commands:  

o diskpart <enter> 
o list disk <enter> 

• You should see the LUN(s) in the list of disks. If not, check the connection(s) between the 
server(s) and the storage and confirm that the LUN(s) has been mapped to the server(s) from 
the storage. 

• Verify that the LUN(s) to be formatted with Melio FS is not configured for “Read-only” mode. 
To accomplish this, enter the following commands in diskpart: 

o select disk # <enter>   (# equals the number assigned to the LUN) 
o attributes disk <enter> 

If the LUN(s) is set to “Read-only” mode, enter the following command: 
o attributes disk clear readonly <enter> 
o attributes disk <enter> 

The LUN(s) should now appear with “Read-only” set to “No”. 

• Download and save the Melio setup program on the desktop of your servers. 

• If a prior version of Melio is already installed, please refer to Tech Brief 
http://blog.sanbolic.com/?p=2096 to review best practices for upgrading your Melio software. 

• Beginning with Melio 3.5, licensing is now volume-based rather than server-based. Please 
refer to Tech Brief http://blog.sanbolic.com/?p=2155 to learn more about licensing your Melio 
3.5 software. 

 
Installation 

 
Double-click the Melio setup program on a server running one of the supported operating systems 
listed under the Supported Operating Systems section on the previous page. 
 
A security warning will be displayed: 
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Click “Run” to proceed with the installation. 
 
A "Welcome" screen will be displayed: 
 

 
 
Click “Next” to continue with the installation. 
 

 
 
Select “I accept the agreement” to accept the license agreement and click “Next” to continue. 
 
The “Upgrade Information” window will appear: 
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If Melio is being installed for the first time, select “This is a new installation – continue” and click “Next”. 
 
If a prior version of Melio is already installed and you are running the Melio setup program to upgrade 
the Melio software, please refer to Tech Brief http://blog.sanbolic.com/?p=2096 to review best 
practices for upgrading your Melio software. 
 

 
 
In the “Select Destination Location” window, select an installation folder for the Melio software and 
click “Next”. 
 



 

11 

 

 
 
Select the components you would like to install and click “Next”. 
 
Note: In order to use the Melio software, at a minimum the radio button for Melio FS / Melio Volume 
Manager must be selected. 
 
In the “Configure Windows Firewall” window, leave the default option to open port 7777 for TCP and 
UDP communications checked to allow the Melio software to function properly. 
 

 
 
Note: If you decide to change the IP/port pair (socket) used by Melio at a later time, the Melio software 
will automatically reconfigure Windows Firewall to accommodate for the new settings. 
 
If you are using a third party firewall, you will need to configure the port exceptions manually to ensure 
the Melio instances running on the servers are able to communicate with one other. 
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Note: If any instance of Melio is unable to communicate with the Melio instances running on the other 
servers in a cluster, that server will not be able to access any volumes formatted with Melio FS. 
 
Click “Next” to continue. 
 

 
 
In the “Select Accounts for Melio Disto and SILM” window, enter the machine account(s) that will be 
used by the Melio Volume Manager to manage Melio shared volumes and the SILM™ data mover 
utility to copy or move files based on user-defined policies (see SILM Users Guide) and click “Next”. 
 

 
 
In the “Ready to Install” window, click “Install” to install the selected components. 
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Click “Finish” to complete the installation of Melio. 
 
After the setup program is completed, the Melio FS kernel driver will start. 
 
Note: All Melio components selected during the installation will appear under the Start menu (Start > 
All Programs > Sanbolic). 
 
Repeat the installation process on all computers that will share access to Melio volumes. 
 
Once Melio is installed on all computers, proceed to Managing a disk with Melio Volume Manager 
(below) to create your shared storage. 
 

Trial Version 

 
During the Melio software evaluation you will receive a trial key that activates the Melio software on a 
per volume basis. With the trial key, you can activate a maximum of two volumes for 15 days. Upon 
trial expiration, all Melio shared volumes will transition to “read-only” mode and only one server will be 
allowed to access the volumes. 

 

Managing a disk with Melio Volume Manager 
 
Note: Prior to managing a disk with Melio Volume Manager, at least one partition (LUN) on your SAN 
storage must be provisioned and presented to every computer running the Melio software. 
 
Launch the Melio Volume Manager (Start > All Programs > Sanbolic > Melio Volume Manager). 
 
By default, the local computer running Melio will be displayed on the left-hand side of the Melio 
Volume Manager console. (See illustration on following page.) 
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Right-click on the disk label on the left-hand side of the lower window pane and select “Manage” to 
manage a single disk or “Manage Multiple” to manage multiple disks. 
 
A pop-up window will appear asking you to select the disk(s) that you want Melio Volume Manager to 
manage. 
 
Note: Unless advised by Sanbolic Technical Support, you should NOT make any changes to the 
values of the parameters listed under the “Timings” section. The default values are designed to work 
under the majority of use cases. (Descriptions for these parameters are provided later in this manual.) 
 

 
 
Select the disk(s) to manage and click “OK.” 
 
Note: After clicking “OK” to manage the selected disk(s), a message will appear informing the user 
that the initial process of managing the disk(s) will take approximately five minutes. 
 
It is important to note that the process of managing a disk can take as long as 10 minutes due to the 
number of tasks involved, regardless of the number of disks selected or the size of the disk(s). Please 
do not attempt to cancel this process until it has completed successfully. 
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After the disks are managed, the following screen is displayed. 

 

 
 
To create a partition on a managed disk, right-click on the disk (where it shows “Empty”) and select 
“New.” 

 

 
 
Select the desired partition size by entering numbers in the “Size” field or using the red slider bar. 
To create a partition using the entire available space, simply click “OK.” 
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When this step is completed, the new partition (displayed below in blue) will appear in the tree view in 
the upper left-hand window pane. A blue partition indicates that the partition is ready to be created. 
 
To create the partition, select “Action > Apply Changes” from the toolbar or press F3. 
 

 
 
A pop-up window will be displayed asking for confirmation. Click “Yes.” 
 

 
 
Once the changes are committed to the disk, the color of the partition will change to black, indicating 
that the partition has been created. 
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Now the partition can be converted to a logical drive (volume) that can be accessed by Windows. 
 

 
 
Right-click on the partition in the upper left-hand window pane and select “Create Logical Drive…” 
 
A dialog window will appear asking you to assign a drive letter to the new volume. The setting "Try to 
set this letter, if available, on each machine that has access to the volume" means the Melio Volume 
Manager will attempt to supply Windows with the same drive letter for this volume on all machines that 
will be sharing access to the volume. In cases where the drive letter is already in use by a machine, 
Melio Volume Manager will supply that particular machine with the next available drive letter for this 
volume. It is also possible to mount a Melio volume on an empty Melio FS or NTFS folder using mount 
points. To mount a volume on an empty folder, check the radio button labeled “Mount to an empty 
folder” and enter the path to the folder. 
 

 
 
Under “Initial Security,” select the option “Give everyone full control.” 
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Under “File System,” leave the option to format the volume with “Melio FS.” 
 
Enter a label for the volume in the “Volume Label:” field. (Optional) 
 
Click “OK” to create the volume. A window containing messages about the volume creation process 
will appear. 
 
Note: During the volume creation process, if Windows prompts you to format the volume, click 
“Cancel” as the volume is already being formatted with Melio FS. 
 
Note: If Windows prompts you to restart the machine, click “Cancel”. Restarting the machine is not 
necessary. 
 
If you receive a warning message about a non-signed driver being installed, click “Continue Anyway” 
to proceed with the driver installation. 
 
Once the volume has been created, a message will appear in the window stating that all steps have 
completed successfully. Click “OK” to close the window and return to the Melio Volume Manager. 
 
Notice: A disk that cannot be managed by the Melio Volume Manager is displayed as “Unknown” or 
“Foreign.” This indicates that another volume manager is actively managing the disk. To manage the 
disk with the Melio Volume Manager, it must first be unmanaged by the other volume manager. To 
accomplish this, you need to delete all partitions on the disk. If the disk is “dynamic,” you must convert 
it to a “basic” disk using Windows Disk Manager. Note that deleting partitions on a disk or converting a 
disk from dynamic to basic will delete all data stored on the associated volume. Make sure that any 
data you need is backed up to another volume PRIOR to deleting partitions or converting the disk. 
 

Creating a Stripe Set 
 
On your storage controller, create at least two LUNs of identical size. 
 
Note: All partitions making up a stripe set must be exactly the same size. 
 
Follow the instructions provided in the previous section to create at least two partitions managed by 
the Melio Volume Manager. 
 

 
 
Right-click in any open area in the top left window pane and select “New > Stripe Set.” 
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A pop-up window will be displayed, asking for the size of the stripe set. By default, the stripe size is set 
to 64 KBs, which corresponds to the default stripe size of most contemporary disk arrays. 
 

 
 
A new empty placeholder for the stripe set will appear in the top left window pane. 
 

 
 
Add the partitions to the stripe set by left-clicking on them (one at a time) and dragging and dropping 
them onto the stripe set. 
From the toolbar, select “Action > Apply Changes” to create the stripe set. 
 
To make the stripe set visible to Windows as a logical drive (volume), follow the steps described 
previously to create a logical drive. 
 

Creating a Volume Set 
 
To create a volume set, follow the same steps used to create a stripe set, only this time, right-click on 
any empty space in the upper left-hand window pane and select “New > Volume Set.” 
 
Note: Unlike stripe sets, the partitions making up a volume set do not have to be the same size. 
 
Drag and drop partitions onto the volume set placeholder and select “Action > Apply Changes” from 
the toolbar to create the volume set. 
 
To make the volume set visible to Windows as a logical drive (volume), follow the steps described 
previously to create a logical drive. 
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Creating a Mirror Set (RAID1) 
 
Follow the instructions provided earlier to create at least two partitions managed by the Melio Volume 
Manager. 
 
Note: The partitions making up a mirror set must be exactly the same size. 
 
Right-click on one of the partitions and choose “Mirror” > “Create…” 
 

 
 
In the “Make Mirror” window, select the other partition that will be used for the mirror and click “OK.” 
 

 
 
The mirror will appear in blue. 
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From the toolbar, select “Action” > “Apply Changes” to create the mirror set. 
 
The mirror will appear in orange, indicating that it is synchronizing. 

 

 
 
Once synchronization has completed, the mirror will appear in green. 
 
You can now create a logical drive (volume) on the mirror set. 
 
To make the mirror set visible to Windows as a logical drive (volume), follow the steps described 
previously to create a logical drive. 
 
Once the logical drive has been created, the mirror will resynchronize. 

 

 
 
After synchronization has completed, the logical drive (and its partitions) will appear in green, 
indicating it is ready for use. 
 

Online Volume Mirroring 

An existing volume can be mirrored while the volume is mounted and active. The volume will continue 

to be operational during the mirror creation and synchronization process. 
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Creating a Highly Available Volume 

When a volume structure is mirrored and contains more than one mirror, the volume can remain online 

and accessible even if some disks are missing. In order for this to occur, there must be at least one 

functional pair of mirrored disks and the disks participating in the failed mirror set must have 

participated in the last volume mount. 

 
 
With a missing disk, volume B: is still online and operational. 
 
To break a mirror, right-click on the mirror set and select “Mirror” > “Break…” 
 

Creating a Striped Set comprised of multiple Mirror Sets (RAID10) 
 
Create two mirror sets as described in the previous section. 
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Then create a new stripe set and drag and drop the two mirror sets (one at a time) onto the strip set. 
 
From the toolbar, select “Action > Apply Changes.” 
 
The two mirror sets will now appear under the stripe set. 

 

 
 
To make the stripe set visible to Windows as a logical drive (volume), follow the steps described 
previously to create a logical drive. 
 

Breaking a Mirror 
 
To break a mirror, right-click on the mirror set and select “Mirror” > “Break…” 
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Select a partition to remove from the mirror set and click “OK.” 
 
From the toolbar, select “Action > Apply Changes.” 
 
The logical drive will now be left with a single partition. 
 

Simple volume mirroring – Breaking a mirror when a mirrored disk is missing 

When a volume is comprised of a single mirror set and one of the disks in the mirror fails, the volume 

will become inaccessible. To make the volume accessible, follow the instructions provided above to 

remove the failed disk and break the mirror. Once the failed disk is removed from the mirror, the 

volume will become accessible. 

Online volume mirror breaking 

A mirror set can be broken while its volume is mounted and active. To break the mirror, the mirrored 

pair of disks must be fully synchronized. Follow the instructions provided above to remove one of the 

disks and break the mirror. The volume will continue to be operational while the disk is being removed 

from the mirror and after the mirror has been broken. 

 
 

Volume Extension 

Additional storage (i.e., partition, volume set, stripe set or mirror set) can be added to an existing 

volume without disrupting its operation. This process forms a volume set comprised of the original 

volume and the newly added storage. 

To extend a volume (logical drive), follow the instructions provided previously to create a new partition, 

volume set, stripe set or mirror set and apply the changes. Drag and drop the new partition/volume 

set/ stripe set/mirror set onto the volume that you want to extend and apply the changes to extend the 

volume. Once the volume is extended, it will be displayed (with its new size) as a volume set in the 

Melio Volume Manager console. 
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Note: You cannot extend a volume set that contains only basic partitions with a Stripe set. This is due 

to the difference in sector sizes between the partitions and the stripe set. 

Note: Volume shrinking is not supported. 

Extending a Disk 

If you run out of free space on a disk, you may be able to add free space (provided there is unused 

storage resources available and your storage hardware supports LUN extension) using the storage 

management application for your storage hardware. Once the LUN is extended, select “View > 

Rescan Disks” from the toolbar at the top of the Melio Volume Manager to allow Melio Volume 

Manager to recognize the additional disk space. Right-click on the new disk space and select “New” to 

create a new partition. From the toolbar, select “Action > Apply changes” and then drag and drop the 

new partition onto the original volume (logical drive). Apply the change a second time to extend the 

volume on the fly (without rebooting the system). The extended volume will be displayed in the Melio 

Volume Manager console. 

Note: Shrinking a disk is not supported. 

Volume Security 

Since Melio Volume Manager is a cluster volume manager, it is important to remember that security 

permissions can be applied to a volume only and not to disks, partitions, volume sets, stripe sets or 

mirror sets. A volume is the resource for which users are granted/denied access. Like any other 

protected object in Windows, each volume has a security descriptor that defines user access to it. 

When security permissions can be applied to a particular object, the respective option is enabled in the 

context menu. 

 
 
Two agents can operate with volumes: 
 

1. A machine user account represents the machine from where the volume is accessed. The 
credentials of the machine user account are necessary in order to start the Melio Volume 
Manager service. The rights of the machine user account define the following: 

a. Whether the volume will be visible on a particular machine or not, AND 

b. If the volume is visible, what access rights are enabled for it: read only, write only or 

read/write. 
 

2. A common user (i.e., John, Mary, etc.) – Individuals who can make changes, edit 
configurations, etc. To make changes from the User Interface of the Melio Volume Manager, 
the credentials of the common user apply. 
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Most likely, the machine user account will be the account entered during the installation of the Melio 

software. If this account or its credentials need to be changed, you can make these changes from the 

Melio Volume Manager service tab of the Global Settings dialog. 

 

Using Melio to format a disk managed by another disk manager 
 
Important note: Melio works with “basic” disks only and does not support “dynamic” disks. Converting 
basic disks that will be formatted with Melio FS to dynamic disks can lead to volume instability. 
 
Although Sanbolic strongly recommends managing Melio volumes with Melio Volume Manager, 
volumes managed by Windows Disk Manager or another third-party volume manager can be 
formatted with Melio FS to allow such volumes to be shared amongst multiple Windows servers. 
 
Note: Prior to formatting a volume with Melio FS, a drive letter must be assigned to the volume, which 
can be achieved using the Windows diskmgmt.msc management console. Make sure the disk has 
been assigned to all machines running Melio that will need to access it. Since Windows Disk Manager 
is not designed to manage shared volumes, it may be necessary to launch Windows diskmgmt.msc on 
each machine and assign the volume a drive letter. 
 
To format a volume with Melio FS, right-click on the associated drive in Windows Explorer and select 
"Melio Format". 
 

 
 

Note: Formatting a volume with Melio FS via the Windows context-sensitive (right-click) menu must be 
performed from one machine only. Once the volume has been formatted, all servers running Melio will 
automatically discover and mount the shared volume. 
 
A confirmation message will be displayed: 
 

 
 

Click “Yes” to format the volume with Melio FS. 
 
Formatting a volume with Melio FS may take several minutes to complete. Please allow the formatting 
process to complete before attempting to access the drive. 
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Reformatting a volume with Melio FS – If the volume was previously formatted with Melio FS and other 
machines are accessing it, the reformat operation will fail and an error message will be displayed. To 
format the volume, you must ensure it is not in use by other machines and that there are no open 
handles referencing it. The simplest way to accomplish this is to shut down all machines accessing the 
shared volume except the one machine being used to reformat it. 
 
Note: Formatting a volume previously formatted with a file system other than Melio FS is not 
recommended as it could lead to volume performance or stability issues. In the event that a previously 
formatted volume must be used, it is imperative that all machines accessing the volume except one be 
disconnected from the storage or shut down prior to reformatting the volume with Melio FS. 
 
Sanbolic strongly recommends formatting only new (raw) LUNs with Melio FS. 
 

Melio Shell Extension 
 
The following tasks can be performed using the Melio Shell Extension: 
 

• Repair volume 

• Format volume 

• Check all machines that are using a volume 

• Check all programs that are accessing files on a volume 

• Manage Snapshots on a volume 
 

 
 

Usage 
 
Melio is a shared file system that supports all standard file system operations such as creating, 
copying, moving, renaming and deleting files and directories, reading from and writing to files, 
changing file and directory attributes, locking whole files or particular sections only, etc. 
 
Since Melio is a shared file system, all of the above operations can be safely performed on a volume 
by multiple machines simultaneously. 
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At the core of Melio is a kernel level driver whose functionality is accessed indirectly through Windows 
Explorer and all user applications using operating system commands such as "copy" or "dir" or via the 
standard Win32 programming functions such as CreateFile(). Melio is tightly integrated with Windows 
Server 2003 and 2008 operating systems and supports all commands and system API functions 
natively. Thus an application that works with NTFS will also work with Melio. 
 
Melio is a fully-journaled file system, which means that all metadata changes are recorded in a special 
area on the disk called a journal (transaction log). If a machine crashes for example, the file system 
may be left in a non-consistent state, potentially leading to data corruption. To prevent this, all 
interrupted operations are checked and replayed using the journal as soon as the volume is accessed 
by one of the machines in the cluster (not necessarily the crashed machine). It is important to note 
that, depending on the number of operations that were taking place during the failure, the process of 
replaying a journal can take some time and during this time delays in I/O operations can be expected. 
 

Additional tuning of Melio 
 
Additional parameters can be configured within the Melio Configuration utility (Start > All Programs > 
Sanbolic > Melio Configuration). 
 
Important note: The default parameters and values for Melio are designed to work under the majority 
of configurations. Modifications made to any of the parameters described below should not be made 
without first conferring with Sanbolic Technical Support. 
 

Configuring TCP/IP settings for Melio 

 

 
 
Melio uses both TCP and UDP protocols for communications between Melio instances running on all 
machines participating in a Melio cluster. A Subnet Range address must be selected if a machine has 
more than one IP address (select “View > Driver Settings” in the Melio Volume Manager console). If a 
machine has only one IP address, you can leave the value at the "Default IP" setting. 
 
Note: Melio supports the following network configurations: 
 
Dynamic Host Configuration Protocol (DHCP) 
IPv6 
Multiple subnet ranges 
 
Note: Multicast IP address – If you experience network problems in the Failover Cluster, select a 
different Multicast IP address. Change it for all cluster members. 
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Fine tuning Melio 

 
Disk Flush Disabled - Setting this option may help in situations where hardware issues exist. Certain 
disk storage does not support this command or support it effectively (usually when the command is 
issued it takes a lot of time to be completed by the underlying storage). When checked, Melio will not 
issue disk flush commands. If unsure, leave unchecked. 
 
Pre-allocation Disabled – Setting this option is not recommended unless advised by Sanbolic 
Technical Support. 
 

Modifying cluster-wide times 
 
These times affect the operation of all machines participating in a Melio cluster. The parameters are 
volume-specific and once changed, are written to the respective volume and propagated throughout 
the entire cluster. 
 
Note: Cluster Times values are written directly on the volume, which requires that the volume be 
locked temporarily by one machine. This will make the respective volume inaccessible to all other 
machines in the cluster for a short time while the changes are written. Also, you must ensure there are 
no open files and/or handles for this volume on the other machines, as this will prevent the volume 
from being locked. If there are any open files and/or handles for the volume, the message "Failed to 
lock volume. Access is denied." will be displayed. Note all times are in milliseconds. 
 
Max IO Time - This is the maximum time an operation to or from the shared disk can last. 
Heartbeat Period - This is the time interval at which the heartbeat check is invoked. 
Max Net Roundtrip - This is the maximum time in which a machine expects to receive an answer 
from the other computers in the cluster to its request over the TCP/IP network. 
Max OS Response Delay - The interval between the expected start of a system operation in the 
computer and its real start. Unless the computer is under constant 100% load, this value should not be 
changed. 
Min Crash Recovery Delay - This is the minimum time it takes for the cluster to determine that a 
machine is not responding and evict it from the cluster. While this process takes place, I/O operations 
may be disrupted, depending on the file system’s read/write pattern. This is because machines must 
refrain from changing data on the disk in order to ensure its integrity. This delay depends on all the 
preceding parameters. It cannot be directly changed and is calculated based on the other values. 
 
Clicking the "Reload" button refreshes the volume values. After applying changes to Cluster Times 
values, press the “Reload” button to see the latest values. 
 

Viewing/modifying registration details 

 
Using the registration window (see screen below) you can transition the operational mode of Melio 
from “Trial” to “Full” mode, apply a new Melio license to upgrade to another edition of Melio, or check 
which features are currently enabled. 
 
Transitioning from “Trial” to “Full” mode takes place dynamically. Simply enter the user name, 
company name and serial number and click “Apply.” 
 
Note: Every machine participating in a Melio cluster that is running in “Full” or “Registered” mode 
must have a unique license key installed. Machines using the same license key will be removed from 
the cluster and will not be able to access any Melio shared volumes until unique license keys have 
been applied. Running different editions of Melio on machines participating in the same cluster is also 
not supported. In either of these situations, a message will be written to the System event log. 
 

Per Process tweaks 

 
There are a number of settings that affect the way a process behaves. 
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• Report fs as NTFS – Specifying a value other than zero enables this setting, which some 
applications may require in order to work properly with Melio. 

• Disable Access Time Update - Specifying a value other than zero enables this setting, which 
suppresses the "Date accessed" property of files. With this parameter enabled, a significant 
increase in performance may be observed when working with files and/or directories, i.e., 
viewing directory contents, reading files, opening multiple files, etc. 

Warning: This parameter should only be enabled when instructed by Sanbolic technical support!!! Enabling 
this parameter on your own accord may present undue risk. 

• Block application access - Specifying a value other than zero enables this setting, 
preventing the specified application from accessing the file system. 

• Ignore Write Through - Specifying a value other than zero enables this setting, causing the 
file system to ignore the FILE_FLAG_WRITE_THROUGH. 

Warning: This parameter should only be enabled when instructed by Sanbolic technical support!!! Enabling 
this parameter on your own accord may present undue risk. 

• Ignore No Buffering - Specifying a value other than zero enables this setting, causing the file 
system to ignore the FILE_FLAG_NO_BUFFERING. 

Warning: This parameter should only be enabled when instructed by Sanbolic technical support!!! Enabling 
this parameter on your own accord may present undue risk. 

• Enforce Write Through - Specifying a value other than zero enables this setting, which 
enforces the FILE_FLAG_WRITE_THROUGH. This setting may fix fluctuations in the 
performance of certain applications, i.e., video applications. 

Warning: This parameter should only be enabled when instructed by Sanbolic technical support!!! Enabling 
this parameter on your own accord may present undue risk. 

• Enforce No Buffering - Specifying a value other than zero enables this setting, which 
enforces the FILE_FLAG_NO_BUFFERING. This setting may fix fluctuations in the 
performance of certain applications, i.e., video applications. 

Warning: This parameter should only be enabled when instructed by Sanbolic technical support!!! Enabling 
this parameter on your own accord may present undue risk. 

• Dirty Page Threshold – Specifying an integer value informs the system of the threshold for 
dirty pages within the system’s cache before they are flushed. For example, if there are 
multiple files opened by the specified process, this setting will affect the dirty pages of each 
file. The default value is 0, indicating that there is no threshold. This setting is on a per file 
basis. 

Warning: This parameter should only be enabled when instructed by Sanbolic technical support!!! Enabling 
this parameter on your own accord may present undue risk. 

• Allow Open Paging File 
• Strict Write Through 

• Ordered Asynchronous NO_BUFFERING IO`s 
• Cluster Size [bytes] 

 

The settings that correspond to the [Default] process are global settings* - they affect all processes. If 
a process is added, its settings will override the global ones. 
 
You can add a process by right-clicking in the Process pane. This will allow you to browse for the 
executable file. To add the preferred settings, you must select the desired process first and then right-
click in the "Tweaks for process" window pane. You will notice that the relevant process is displayed 
after "Tweaks for process". 
 
* Note: It is not recommended to change global settings as this may lead to unexpected behavior of the file 
system. Instead, changes should be made on a per process basis. 
 

Per Volume tweaks 

 
These tweaks manage the behavior on a per volume basis. These can be set globally for all Melio 
volumes by using them on the [Default] placeholder or individually for each volume available. 
 
There are two per volume tweaks. 
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1. Quality of Service /QoS/ - Select the appropriate volume, right click in the "Tweak Name" 
column and choose "Add Enable QoS" from the menu. A value of 1 (enabled) will be added to 
the tweak. Note: QoS is disabled by default. 

2. Level 1 batch oplocks. Enabling this tweak (specifying a value other than zero) disables Level 
1 batch oplocks on the specified volume. 
 

Quality of Service (QoS) 
 
To use this feature, please enable it as described in “Per Volume Tweaks.” QoS allows a user to 
assign a specific amount of the total throughput available in a storage controller to one or more 
processes running on a machine and/or one or more VHDs. 
 
Priorities are managed by a point system starting with the lowest priority (1) and ending with the 
highest priority (1000). You can add a process by right-clicking in the Process window pane, which will 
allow you to browse for the executable file. To add the preferred settings right-click, select a process 
and edit the “Points” column by entering the desired value. 
 
The following is an example of how to use QoS: 
 
There are two processes – A and B, both of which are bandwidth intensive, and two other processes – 
C and D, which do not require as much bandwidth. Here is a scheme of the processes points: 
 
A – 10 points 
B – 10 points 
[Default] – 5 points 
C – 1 point 
D – 1 point 
 
Based on the above described point scheme, with Process A and Process C running at the same time, 
IO bandwidth will be redistributed between them as follows: Process A will have 9/10 (90%) of the 
bandwidth reserved, while Process C will have only 1/10 (10%) of the bandwidth. 
 
QoS by Filename works in conjunction with the per process scheme described above. Points assigned 
to a file/file group/folder are added to the ones for the process and then bandwidth reservations are 
calculated as above. If wildcards are used to generalize particular types of files, the process accessing 
them will get points added for all of them as a whole. Of course QoS can be set on a file by file basis 
by assigning weights to individual files, not groups. 
 
It is important to note that every process participating in QoS computation has points assigned - either 
explicitly set or using the default. 
 

Supported features in the registered version  
 
You can obtain a registered version of Melio with partial or all features enabled. Melio offers the 
following features: 
 
Number of machines allowed simultaneous access to a volume – Licenses can be purchased that 
allow a specific number of machines or an unlimited number of machines to share access to one or 
more Melio volumes. 
Modify security – With this feature enabled, you can modify the files and directories security. 
Extend volumes – This feature allows you to extend Melio shared volumes. Note the ability to extend 
a Melio volume is only available when the volume is managed by Melio Volume Manager. 
Reparse points – Enabling this feature will allow a user to make use of the reparse points’ 
functionality. 
Sparse files – These are files that are mostly empty, enabling this feature allows you to use software 
that requires sparse files. 
Modify cluster affinity – Cluster Affinity allows a specific cluster machine (or group of clustered 
machines) to keep the connection to a shared volume after it has lost communications with the 
remaining machines participating in the cluster. 
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QoS – This feature can be used to define how storage throughput is shared amongst applications 
accessing a particular volume. QoS can be set on a process or file/class of files basis. 
Extended file attributes – Allows users to associate computer files with metadata not interpreted by 
the file system. This feature enables NTFS compatible extended file attributes on Melio. 
Open file by ID – File ID is a 64bit reference number for a file. This number is assigned by and 
specific to a particular file system. An application can use a file_id to open the corresponding file. 
Windows folder and file sharing – This feature allows files and folders stored on Melio shared 
volumes to be shared via file-sharing protocols (i.e., CIFS or NFS). 
Volume shadow copy (Snapshot)/ Writable Snapshot – The snapshot capability allows fully-
journaled snapshots to be created from any machine in the cluster. The snapshot capability supports 
standard APIs and can be invoked by industry-standard VSS backup software. 

Hard links – Directory entry that associates a name with a file on a file system. 
Quota – Specify access permissions to Melio shared volumes for Windows users or groups. 
 

 
 
Full layout repair with new UI – Supported in Melio from Melio Shell Extension. 
Per-volume activation with dynamic server-side feature selection – Melio is licensed on a per-
volume basis, which can be activated online or manually via the Melio Configuration utility. 
SCSI reservations – Melio supports SCSI reservations. 
 

Command line utilities 
 
set_cluster_affinity.exe* – This utility is located in the Melio installation folder (C:\ Program 
Files\Sanbolic\Melio\ by default) and is used for cluster affinity feature administration. Weights can be 
assigned on the same Melio volume from different machines. By default all volumes on all machines 
have a cluster weight of 1, making them equal. The syntax is as follows: 
 
set_cluster_affinity.exe \\.\x: <weight> or 
set_cluster_affinity.exe \\?\Volume{dab8cf5f-eede-11d9-935e-0011d89ce0a0} <weight> 
 
In case of TCP/IP network connection loss between one or more machines, the cluster can split into 
several isolated clusters attempting to access the shared volume. Normally this can lead to a split-
brain situation in which different cluster groups think they own the same volume exclusively, which can 
result in data corruption. To prevent this situation from occurring, fencing mechanisms are used to 
dismount the volume on “misbehaving” machines. When cluster affinity is set, weights are summed up 
and the heaviest cluster (highest total weight value) becomes the current owner of the volume, with all 
remaining machines removed from the cluster. 
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For example, if you set the weight for a particular volume on one of the machines greater than the 
number of cluster members and deliberately disrupt the network connection between them (i.e., 
changing the Melio TCP/UDP port number), all machines except the one with the heaviest weight will 
leave the cluster. 
 
Note: Cluster affinity is available in Melio Enterprise and Melio Private Cloud editions and will return an 
"Incorrect function" error message in the Melio VDI edition. 
 
vss_client.exe* – This utility is located in the Melio installation folder (C:\ Program 
Files\Sanbolic\Melio\ by default) and allows the manipulation of the cluster wide Melio VSS compatible 
snapshots. Below is a list of supported commands: 
 
Create Shadow - create a new volume shadow copy 
Delete Shadows - delete volume shadow copies 
Delete ShadowSet - delete an empty shadow set 
List Shadows - list existing volume shadow copies 
List Providers - list registered volume shadow copy providers 
List Volumes - list volumes eligible for shadow copies 
Expose Shadow - expose the shadow copy as a regular mount point or a network share 
Unexpose Shadow - remove an exposed shadow copy 
The syntax is very similar to the default vssadmin Volume Shadow Copy Service administrative 
command-line tool included in all Windows operating systems supporting VSS. For example, to create 
a volume shadow copy of a Melio volume: 
C:\Program Files\Sanbolic\Melio >vss_client.exe create shadow /for=X: 
Melio Volume Snapshots management tool. 
Successfully created shadow copy for 'X:' 
Shadow Copy ID: {ae24550c-446e-4f60-b8e8-634d1ff3c56b} 
Shadow Copy Volume Name: \\?\GLOBALROOT\Device\Volume{ae24550c-446e-4f60-b8e8-
634d1ff3c56b} 
Then the shadow copy can be deleted, exposed as a network share, etc. 
 
Note: There is also a GUI application called Snapper (included with Melio) that can be used to create 
and manage volume shadow copies. This application can be accessed from the Sanbolic folder in the 
Start menu. 
 

Sanbolic VSS GUI tool (Snapper) 
 
Melio includes an easy-to-use graphical utility called Snapper that makes working with Melio VSS 
Snapshots extremely simple. This utility allows users to create and delete snapshots and 
mount/dismount (expose) them either locally via Explorer.exe or as a network share accessible via 
UNC, thereby allowing the read only point in time copy of the whole volume to be accessed via the 
standard Windows file and folder sharing feature. Each action has a corresponding event in the 
“Messages” section in the bottom-right window pane of the interface, showing the operation status 
returned – success or a particular error message. (See illustration on following page.) 
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Troubleshooting 
 
This section includes several steps that can be performed if issues arise when using Melio shared 
storage. 
 

• First, make sure that your storage hardware is working properly. Check the system and 
application event log for error messages. If there are timeouts, controller or device errors, or 
something else, fix them according to your storage manufacturer’s guidelines. 

• Confirm that all machines participating in the cluster are running in the same mode (Trial or 
Full). If the machines are running in Full mode, ensure that each machine is using a unique 
license key for the same edition of Melio (i.e., Melio Enterprise, Private Cloud or VDI). Mixing 
different editions in the same cluster is not supported. To check which mode and edition of 
Melio is running, go to Start > All Programs > Sanbolic > Melio Configuration > Help > About. 

• Confirm network connectivity between all the Melio machines in the cluster. This is especially 
important on multi-homed systems (systems with several IP addresses). Make sure Melio 
uses the correct IP addresses on the machines so Melio instances can communicate across 
the network. Also ensure that all Melio instances are set to the same port number (this applies 
to both TCP and UDP). 

• Check the Event log for messages generated by Melio. The file system reports information, 
warning and error messages in the System event log that can offer insight regarding how to 
proceed with troubleshooting (i.e., pointing to a network connectivity issue, disk array problem, 
etc.). 

• Check the version of Melio being using by checking the information shown via Help > About in 
the Melio Configuration tool. This will help you determine if you need to download an update 
for Melio. 

• If you experience any anomalies, you can compare Melio with NTFS by running the same 
operations on an NTFS volume. If both file systems behave the same, then this is the intended 
behavior and is not indicative of a problem. 

 

How to request technical support 
 
For technical assistance, contact Sanbolic Technical Support through one of the following methods: 
 
Online: Log into the Sanbolic clients system at http://clients.sanbolic.com/ and enter a support ticket. 
Email: support@sanbolic.com 
Phone: 617-833-4242 
 
When you submit a support request, please refer to the following guidelines: 
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1. Supply information on your hardware and software. 
2. Supply the exact Melio version. 
3. Describe the steps to reproduce the problem. 
4. Supply System event logs from all machines participating in the Melio cluster. 
5. Supply the exact error message(s). 
6. Specify how many times the problem has occurred. 
7. State the actual results. 
8. Describe the expected results. 
 

1. Supply information on your hardware and software 
 

Use the All programs-> Accessories-> System tools -> System information or other product that will 
give details about the software and hardware being run on the system. 
Please describe the configuration of your central storage. Specify the type and speed of the 
connection to the hosts, the type of the disk array - JBOD or RAID, the model of the hard disks. Also 
describe the RAID controller, the RAID level, type of RAID (hardware/software), what software 
achieves the RAID functionality (Windows or third-party). Describe the topology of your 
storage network (how many hosts, how many disk arrays, how many loops, etc.). 
 

2. Supply Melio version 
 

The version of Melio can be obtained by using the Melio configuration tool. Launch the tool, select 
from the menu Help- >About and write down the driver information at the bottom of the message box. 
Please make sure that you run the same version of Melio on all your machines. If for some reason this 
is not the case, please state the version of Melio on each of the machines. 
 

3. Describe the steps to reproduce the problem 
 

Please write down the exact steps that led to the problem. If Sanbolic Technical Support is unable to 
reproduce the problem, it may be difficult to identify, investigate and fix the problem. 
 
Due to the distributed nature of Melio, you will have to include some additional information as well. 
Take notes of the order in which machines were started - this directly corresponds to the order they 
enter the cluster and also affects some other aspects of Melio operation. 
 

4. Supply System event logs 
 

Please send system and application event logs from all your systems forming a cluster. Melio writes its 
information in the System event log, but other software (e.g. MS SQL) enters important information in 
the Application event log. The event logs should be in native binary format (not as text files). To do so, 
perform the following steps: 
 

� Launch Event viewer (Start menu -> Run... -> type "eventvwr" without the quotes) 
� Select System Log, from the ‘Action’ menu select ‘Save Log File as…’ Make sure the type of 

the file is “Event Log (*.evt(x))”. 
� Choose "Event Log (*.evt(x))" type of the log while saving. 

 
To help Sanbolic Technical Support get as much information as possible out of log files, please 
provide the approximate time the issue occurred. 
 

5. Supply the error message(s) 
 

If an error message is displayed in a message box, write down the exact text of the message. Please 
translate the text into English, if the message is in some other language. Also you may perform a 
screen capture of the error message as follows: 
 

A. Make sure that the error message is the active window. Press Alt+PrtScn to place a bitmap 
copy of the window in the Clipboard. 
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B. Open the built-in MS Paint bitmap editor, and paste the image. 
C. Go to "File->Save as" and choose a filename. 

 
In case a STOP error occurs that leads to a "blue screen of death", it is important to obtain the kernel 
memory dump that should be created at %SystemDrive%:\Windows\Memory.dmp. If you review the 
memory dump and suspect the STOP error may be Melio related, compress and upload the memory 
dump via the file manager in your account at http://clients.sanbolic.com or to ftp.sanbolic.com. Then 
contact support@sanbolic.com with a problem description according to the steps provided in this 
section. A Sanbolic Technical Support engineer will analyze the memory dump and offer suggestions 
to resolve the error based on his/her findings. 
 

6. Specify how many times the problem has occurred 
 

The best property a problem may have is to be reproducible every time a particular test is run. 
Unfortunately this is not always the case, if a something shows up only once chances are it won't be 
discovered. 
 
Please specify the frequency with which a particular bug is occurring - every time you use the same 
steps, intermittent (how many times in how many tests), just once. 
 

7. State the actual results 
 

Describe the exact results achieved during the test using quantitative values, when possible. For 
example, avoid saying just "the machine hangs". Instead say something along the lines of "Windows 
Explorer stopped responding (hanged), we waited for X minutes, nothing changed, we had to kill the 
explorer process". 
 

8. Describe the expected results 
 

Please describe in detail the expected test results. 
 
 

Contacting Sanbolic 
 
Sanbolic Inc. 
Technical support: 
   Online: http://clients.sanbolic.com/ 
   Email: support@sanbolic.com 
   Phone: U.S.: 617-833-4242 International: +44 20 70 99 20 34 
Information requests: info@sanbolic.com 
Sales inquiries: sales@sanbolic.com 
Web site: www.sanbolic.com 
 
Mailing address: 
Sanbolic, Inc. 
304 Pleasant Street 
Watertown, MA 02472 
USA 

 


